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Introducing GIS

A first look into the concepts that comprise
a Geographic Information System

Dr. Kavinda Gunasekara
Frank Yrle

Strengthening Agro-climatic Monitoring and Information Systems (SAMIS)
to improve adaptation to climate change and food security in Lao PDR

Overview
Learning GIS Fundamentals

1. Who uses GIS?

2. How layers work in a GIS

3. GIS features & surfaces

4. Spatial relationships in GIS



GIS — Geographic Information Systems

Definition

(def) A geographic information system (GIS) captures, stores,
analyzes, manages, and presents data that is linked to locations.

GIS is a set of tools that allow for the processing of spatial data into information.

A good GIS should answer the following questions:

Location — Where is it?
Condition — What if?
Trends — What has changed since?

Relations — Which data are related?

Synthesis of Different Data Sources

All exist in one system

X

0 . .
JFMAMJJASOND

GIS v Analysis
) ) v" Map the Results
v’ Store & Share Data



Applications of GIS
Many disciplines use GIS

Examples of Maps
possible with GIS

Analysis of the effects of land use change on protected areas in the Philippines,
2006

Land Use Change
- Tracking how land is used with time series image analysis
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Population Density Distribution in Bangkok: Each Khwang
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Examples of Maps
possible with GIS

Population Density
- Distribution of people
in relation to area

Train Lines
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Ex: Countries, provinces,
districts, sub-districts,
Cities, etc.
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Examples of Maps
possible with GIS

Utility Management
- Coordinate, map, &
manage, repairs

Ex: Water pipes,
electricity infrastructure

Naperville, lllinois, United States.
2019



Examples of Maps
possible with GIS

Elevation Map
- Elevation of Earth
features

"'"' Quantifying nationwide land cover and historical changes in forests of
Nepal (1930 2014): implications on forest fragmentation, 2018

Examples of Maps
possible with GIS

Precipitation Map
- Amount of rainfall
received over an area

. ——— |

LR

. — - - Source Vi dese Deia Tor weokidoe 3000

World climate data, 2008



Examples of Maps
possible with GIS ’

Rescue Operations
- Planning for Thai cave
rescue mission 2018

Planning for Thai cave rescue mission, ESRI Thailand » - " ~
2018

* Cave interior route & features '” : P &F
* Extent & direction of water flow LV

~5>)‘

183 @ gis @esi new

Examples of Maps S a—
possible with GIS T

Figure 1. Classified land wse'cover (LUC) map of Surat Tham pevvinee i 2007

Table 1. Area coverage of land use/cover change (LUCC) classes in 2007.
LUC Type Area (ha) Proportion (%)
Crop Land (AC) 24,793.02 1.98
Farm Land (AF) 12,050,994 144
Orchard (AQ) 43,688.62 349
Plantation {AP) 665.634.19 53.21
Dense Forest (F) 381372.70 30.49
Degraded Forest (FD) £.893.26 071
Open Forest (FO) 825.03 0.07
Miscellaneous Land {M) 45,822.42 3.66
Urban & Built-up Land (U} 33.004.38 2.64
Water Body (W) 2881314 230
Total urea 1,250,957.61 180.00
= | A dary b
{ b Bem L5 katw ol -
| + 1)
| et Land Suitabilit
" Open Forest (FO) y
Y M 1amdiM .
ol R -A ment of land to determ
e ow G I g e i ssessment OoT 1ana cover 1o aetermine
. Water llady (W1
ible sites for future development
Land Use and Natural Resources Planning Bunmomkacw & Murayame, p OSSI e SI es O r u u re eve O p e n
for Sustainable Ecotounsm, 2012 GiS in Surat Thani, Thaitand



GIS Maps Contain Layers

Interpretation of Real World in GIS

Villages
Roads
Land Parcels

Elevation

Land Cover

Real World
Break-down
the real WOI‘ld Gifferent GISinformation fayers, stacked together. i Coastat Data O oment Certre (NCDOC),
2019 Oceanic ang Atmospaeric ABRinstration (NORAL USA
Layers Contain Features or Surfaces Some layers

Interpretation of Real World in GIS

,_ --ﬁ‘&%- . _'-f_'_i:'“ Villagos Ex. The roads layer

Roads contains many
different roads

contain features

Land Parcels

Elevation e Eachroadisa
feature

Land Cover

Real World

Different GISinformation fayers, stacked together. Coastai Data O Centre (NCODOC),

2019 Nationat Oceasic and Atmeospheric Adminisiraiion (NOAA) USA



Features
Features have shape & size

We typically represent features from the real world
as three distinct spatial elements in GIS:

° Points - simplest element

Lines - set of connected points

Polygons - set of connected lines

Points, Lines, and Polygons are referred to as vector data

Examples of Features on a Map
Learning GIS Fundamentals

businesses

roads



Layers Contain Features or Surfaces

Interpretation of Real World in GIS Some layers are surfaces

Ex. Elevation is

considered a

continuous

property that

— — - Elevation changes from one
location to another

* Eachsquare
represents an
—_— elevation value

Surfaces

Have numeric data; does not use shapes

The most common surface is a raster.
It is @ matrix of identically sized square cells.

Pixel

PIXEL (picture element)

The smallest unit in an image.
In raster based GIS systems,
attribute information can be
assigned to each pixel.

ESRI



Features have Locations
Coordinate Systems

A graticule assists
with finding
locations on maps

Vientiane
17°58'29.4780" N
102°37'51.1212" E

Asia map, 2019

Features have additional information
Learning GIS Fundamentals

v’ Shape Other
v Location Information

Asia map, 2019

10



Features have additional information
Learning GIS Fundamentals

Each province corresponds to a

color in the legend based on . -

population

Laos map, 2019

Overlap of features
Finding new insights

Example of overlay
analysis

One layer is a represents
the floodplain

The other layer contains
information about parcels
Determining which houses
lie within floodplain

ESRI



Overlap of features
Finding new insights

* Example of Overlap between features

* Determining slope of forest patches

* One layer contains polygons of forest
patches

* Another layer represents the slope of
the same area

* Overlay functions reveal the slope at
each of the forest patches

Strengthening Agro-climatic Monitoring and Information Systems (SAMIS)
to improve adaptation to climate change and food security in Lao PDR

University of Nebraska, Omaha

ESRI ArcGIS Environment

A first look into the concepts that comprise
a Geographic Information System

Dr. Kavinda Gunasekara
Frank Yrle

12



Objectives
Day 1 Session 2

1. Introduction to the ArcGIS Desktop applications

2. Know the components of the ArcGIS platform

ArcGIS Desktop Environment
Day 1 Session 2

ArcGIS Desktop

Applications
ArcMap ArcCatalog
ArcToolbox ModelBuilder

]

"

ArcScene

13




Capabilities of ArcGIS

Definitions
File formats compatible with ArcGIS
Query SDC IGDS
SDE layers IGES
. Shapefiles (.shp) MIF
Draw / Edit tools Text files (.txt) MOSS
Excel files (.xls) SDTS (point, raster, and vector)
. . TIN SLF TIGER (through v2002)
Spatial Analysis tools VPE Sun Raster
ADS ADRG Image (.img)
. . AGF ArcSDE raster
Many spatial file formats DFAD DTED Level 0, 1, and 2 (.dt*)
DIME Esri Grid
DLG Hierarchical Data Format (HDF)
ETAK LizardTech MrSID and MrSID Gen 3 (.sid)
GIRAS National Imagery Transmission Format (NITF) (.ntf)
Tagged image file format (TIFF) (.tif)
Shapefile contents
Many file extensions
File
Extension Description
.shp The main file that stores the feature geometry; required.
.shx The index file that stores the index of the feature geometry; required.

.dbf The dBASE table that stores the attribute information of features; required.

.sbn The files that store the spatial index of the features.

.sbx The files that store the spatial index of the features.

.prj The file that stores the coordinate system information; used by ArcGIS.
xml Metadata for ArcGIS—stores information about the shapefile.

characterset to be used.

.cpg An optional file that can be used to specify the codepage for identifying the

ESRI

14



Indexing vector files
Process of indexing

memory address

conrdinates

Al

!

Arc Al

0011

0100

0101

0110

L9

510

pointer

Arc A2

memary address
cogrdinates

A3

A2

Bolstad 2012
GIS Fundamentals

ArcGIS Desktop

1000 | 1001 (1010

13| 9o | 02

po

memaory address

coardinotes

Arc A3
1110 | 1111

02 | 19

inter

pointer

Applications

ArcMap
ArcCatalog
Tools
ModelBuilder

ArcScene

Extensions

Laos map, 2019

15



ArcGlIS Desktop

Applications

ArcMap
ArcCatalog
Tools
ModelBuilder
ArcScene

Extensions

ArcGIS Desktop

Applications

ArcMap
ArcCatalog
Tools
ModelBuilder
ArcScene

Extensions

16



ArcGlIS Desktop

Applications

ArcMap
ArcCatalog
Tools
ModelBuilder
ArcScene

Extensions

ArcGIS Desktop

Applications

ArcMap
ArcCatalog
Tools
ModelBuilder
ArcScene

Extensions

Streamline geoprocessing tasks

Make your own tools

3D Visualization

17



ArcGlIS Desktop

Applications

ArcMap
ArcCatalog
Tools
ModelBuilder
ArcScene

Extensions

ArcGIS Desktop

Applications

ArcMap
ArcCatalog
Tools
ModelBuilder
ArcScene

Extensions

Spatial Analyst

3D Analyst

18



ArcGlIS Desktop

Network Analyst
Applications

ArcMap
ArcCatalog
Tools
ModelBuilder
ArcScene

Extensions

Getting to Know the ArcMap Interface

A first look into the concepts that comprise
a Geographic Information System

Dr. Kavinda Gunasekara
Frank Yrle

Strengthening Agro-climatic Monitoring and Information Systems (SAMIS)
to improve adaptation to climate change and food security in Lao PDR

19



Overview
Getting to know the ArcMap Interface

1. Becoming acquainted with ArcMap structure

2. Visualizing Data

3. Basic Tools for Maps

4. Additional tools

Overview
Coordinate Systems & Projections

1. Examining coordinate systems

2. Projecting Data

3. Defining a map projection

4. Georeferencing a raster

20



Opening ArcMap

Getting Started

When you first open
Arcmap you will be
greeted by the
Getting Started
window. This is
handy for loading a
recent project that
you were previously
working on.

For now, click Cancel to start on a new project.

. After clicking cancel you will be
Opening ArcMap taken to the ArcMap Data Vi
Exploring Features Available aken to the Arciviap Data view

Any data you load will appear
here in the Data View

21



After clicking cancel you will be

Opening ArcMap taken to the ArcMap Data View

Exploring Features Available

The Table of Contents is a

listing of all data that has been
loaded

We can use the Table of
Contents to change the
stacking order of data layers

After clicking cancel you will be

Opening ArcMap taken to the ArcMap Data View

Exploring Features Available

These buttons allow quick
access to opening a new map
document, opening a map
document, saving, and printing

22



Opening ArcMap

Exploring Features Available

After clicking cancel you will be
taken to the ArcMap Data View

Opening ArcMap

Exploring Features Available

Controls for inspecting maps

After clicking cancel you will be
taken to the ArcMap Data View

Buttons to access applications
within ArcMap including
ArcCatalog, Arc Toolbox, and
Model Builder

23



Opening a Map Document

Exploring Features Available
.mxd is the file extension for ArcMap files

I:l 2. Open the file:
2-Map Interface.mxd

1. Pressthe
button to open an existing map document

Overview
Exploring Features Available

The Table of
Contents shows
5 files in the

map document

* Asia

* Percent Forest Area
* GDP

* Life Expectancy

* Other Countries

HLHTT EISEETT Mty

Asia ma p 2019 Country statistics data from The World Bank
)

24



Overview
Exploring Features Available

A closer look at

the Table of

Contents shows us

that the Asia and

Other Countries

layers are active
Asia map, 2019

Layers can be turned on & off
Check / Uncheck

5. When
) you're
Asiamap, 2015 4. Try the same finished
3. Uncheck the Other with the Asia Layer turn both
Countries box in the layers
back on

Table of Contents

25




Table of Contents
Listing Methods

L1

The Blue outline indicates
that method is selected

There are 4 options

for listing data in the

Table of contents
List by Drawing Order

List by Source
List by Visibility

List by Selection

Table of Contents
Listing Methods

[

The Blue outline indicates
that method is selected

. : Drag & drop to
List by Drawing Order change drawing order

6. Try on your own: Make the Percent Forest Area
layer active and drag & drop it above the Asia layer

Asia map, 2019 Asia map, 2019

26



Table of Contents
Listing Methods

Table of Contents
Listing Methods

The Blue outline indicates
that method is selected

Layers are listed by the
geodatabase or folder
containing the data
source they reference

List by Source

Also lists folders associated with the data

The Blue outline indicates
that method is selected

Layers are listed by
whether they are turned
on or off

We have not turned on
GDO or Life Expectancy
layers, so they are listed at
the bottom as Not Visible

27



Table of Contents
Listing Methods

Table of Contents
Listing Methods

The Select Features
tool lets us select
points, line, and
polygons present in
the Data View

The outline indicates that
method is selected

Layers are listed by
whether they are
selected by the
interactive editing
and selection tools

List by Selection

No layers are selected as
indicated by the menu
(no features selected)

Click the Select Features tool, then
select Laos in the Data View. Laos will
be outlined in blue once it’s selected

28



Table of Contents
Listing Methods

Laos now appears in

the selected menu

Laos map, 2019

Asia layer was also activated,
so Laos is selected there too

- Deselect Laos by clicking the
grey square for both layers
Change Name of a Layer Return to List by
Modify Layer Drawing Order

Let’s change the name of the Asia
layer. Currently the name is Asia_pc100
Change the name to Asian Countries

Click Asia_pc100 2x in the
Table of Contents

The name will be highlighted
in dark blue. You can then
type the new name

1-click

2-clicks

Finished

29



|dentify Tool

Gain insight to map layers

The Identify Tool will help us
discover information about
features without having to
open the attribute table

Tools for Exploring the Map

Gain insight to map layers

= m. | Fixed zoom in

On your own:

Use the Identify Tool to
find the 2015 percent
forest cover for Laos,
Indonesia, Kazakhstan,
and Tajikistan

Zoom In Press 1x to zoom in a little

=, | Zoom Out Click & Drag to form a zoom box

Incremental zoom in / zoom out

Fixed zoom out Zoom faster with mouse wheel

Previous Extent  Return to previous view prior to
last zoom or movement

30




Tools for Exploring the Map

Gain insight to map layers

Pan Click and hold the left mouse button to
move across the map

* Can also be achieved by clicking & holding
mouse wheel

Returns to whole view of the map area

Full Extent : .
after zooming / panning

On your own: Practicing zooming and panning with these tools.
When you’re finished return to the full extent of the map

Customizing the wheel zoom
Gain insight to map layers

Zooming with the mouse To change roll /
wheel is quick & convenient. ~ zoom direction:
However, zooming like that Roll Forward

might feel backwards. Select Zoom In

31




Map Tips

Gain insight to map layers

Map Tips — Tool that lets you hover
the mouse over a feature to learn
about data of your choice.

Access the Properties of Percent Forest Area:
Right click the Percent Forest Area Layer and
select Properties (or you can double-click the
layer name)

Map Tips Map Tips — Tool that lets you hover
Gain insight to map layers the mouse over a feature to learn
about data of your choice.

Check the box to turn
Map Tips on for this layer

You can also select the
field that will appear for
the map tip. Choose
CNTRY_NAME

32



Map Tips

Gain insight to map layers

Laos map, 2019

Create a Bookmark
Gain insight to map layers

Laos map, 2019

Map Tips — Tool that lets you hover
the mouse over a feature to learn
about data of your choice.

The Map Tip shows us
the country name
because we selected
CNTRY_NAME for the
Map Tip field

Bookmarks help us keep track of a
place / map extent that we want
to go back to.

Make a Bookmark for Laos.

Zoom to Laos

Click the Bookmarks tab at the top of the screen
Click Make a Bookmark

Name your bookmark: Laos

33



Create a Bookmark Bookmarks help us keep track of a
Gain insight to map layers place / map extent that we want

to go back to.

Laos map, 2019

Go to XY

Pinpoint locations with coordinates

Use the Go to XY tool
to mark locations on

your map — provided L]
that you know the
coordinates

Choice of units

34



Go to XY

Pinpoint locations with coordinates

Choose Decimal Degrees for units
Enter these coordinates into the Go to XY tool

LAT LONG
Bangkok 13.7563° 100.5018°
Vientiane |17.9757° 102.6331°

Use Flash to determine if the

coordinates are correct

Go to XY

Pinpoint locations with coordinates

If the coordinates are correct, click Add Point on the Go to XY tool

L]

Thailand map, 2019

First try Bangkok

Next try Vientiane
LAT LONG
Bangkok 13.7563° 100.5018°
Vientiane 17.9757° 102.6331°

35




Measure Distance
Pinpoint locations with coordinates

Thailand map, 2019

Measure Distance
Pinpoint locations with coordinates

We found Planar Distance to
be approximately 526 km

Try Geodetic distance and
see if there is a difference.

Now that we have two cities marked
on the map, let’s determine how far
apart they are. We will need the
Measure Tool

36




Measure Distance
Pinpoint locations with coordinates

On your own: Use the
measure tool to find the
planar distance and the
geodesic distance between
Vientiane and Istanbul, Turkey

Vector & Raster Analysis
Part 1

Basic useful tools in vector & rater operations

—_— - (data use in this exercise is only for
demonstration purpose only)

Dr. Kavinda Gunasekara
Frank Yrle

Strengthening Agro-climatic Monitoring and Information Systems (SAMIS)
to improve adaptation to climate change and food security in Lao PDR
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Learning topics

Overview o the exercise

Layer symbolizing and use predefined legend
Dissolve tool and options

Clip tool and various ways to utilize the tool
Importing GPS data and crating GIS layer

Proximity tool and options

AN A S o

Several combination of overlay operations to

achieve the specific objectives

N

Field calculator
8. Intersect and union overlay operations

9. Merge and append tools

|. Explore the data

Overview of data

1. Shape files

1. Administrative boundaries

2. Road

3. River

4. Village

5. Landuse_clip

6. .layer file: landuse legend
2. Table data
1. Coordinates of Agro-meto stations

2. Other attributes of Agro-meto stations



|. Explore the data

Overview of data

Laos map, 2019

Symbolize Layers

Assign colors based on data categories

1. Check the categories of data and assign appropriate symbols/colors

2. How to assigned predefined legend/colors based on .layer file?

1. Click Import ~

2. Browse “landuse.lyr”

39



Symbolize Layers

Assign colors based on data categories

1. Check the categories of data and assign appropriate symbols/colors

2. How to assigned predefined legend/colors based on .layer file?

3. Click OK

4. Check the colors
— | 4.Click OK and click OK

l How to make Level 1 Landuse level
and symbolize

* Make level one field landuse



l Landuse Level 2 Landuse Level 1

— Agriculture

o How to make Level 1 Landuse level
and symbolize

—  Forest

Other Land
Urban

——  Water

[Field Name] = “Category Name” {operator} [Field Name] = “Category Name”

Create Province Layer

Use Dissolve tool

1. Open ArcTool Box

2. Data management Tools =» Generalization =» Dissolve

41



Create Province Layer

Use Dissolve tool

Create Savannakhet Province Layer
Export data into separate later

1. Select Savannakhet province

2. [R] click and Data =» Export Data

Laos map, 2019

Laos map, 2019

42



l Data preparation for Savannakhet Province
Use Clip Tool

1. Analysis Tools =» Extract =» Clip

2. Clip all the layers by Savannakhet province layer

l Data preparation for Savannakhet Province
Use Clip Tool

3. Clip landuse layer as well

4. Explore the dataset

Savannakhet, Laos map, 2019
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l Data preparation for Savannakhet Province
Use Clip Tool

Use appropriate symbology

Savannakhet province, Laos map, 2019

Adding GPS data and creating layer

Data preparation

1. Open “Agro-meto_stations.xls” and explore the table

44



Adding GPS data and creating layer

Data preparation

2. Go to File =» Add Data =» Add XY Data

Adding GPS data and creating layer

Data preparation

2. Explore the data, this is temporary file
3. To make it permanent file; [R] click =» Data =» Export Data
File =» Add Data =» Add XY Data

Savannakhet province, Laos map, 2019
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Adding GPS data and creating layer

Data preparation

4. Symbolize the created later

Savannakhet province, Laos map, 2019

Proximity Tools

Use Buffer Tool

1. Analysis Tools = Proximity =» Buffer

46



Proximity Tools

Use Buffer Tool

2. Create 5km buffer for Agromet stations

Savannakhet province, Laos map, 2019

Proximity Tools
Use Buffer Tool: Try with Dissolve Type: All

3. Create 5km buffer for Agromet stations with dissolve polygons

Savannakhet province, Laos map, 2019

47



Proximity Tools
Use Buffer Tool: Try with Multiple Ring Buffer

4. Create 1, 3, 5, 10 km buffer for Agromet stations with dissolve polygons

Savannakhet province, Laos map, 2019

Proximity Tools: Self-task |

Use Buffer Tool: buffer for line feature

1. Create 5km and 8 km buffer zones for “primary” road in Savannakhet province

Savannakhet province, Laos map, 2019
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l How many villages within 10km distance to all
agromet stations in Savannakhet Province?

Answers by Participants:

15t place: 393 villages by Natnakhone SAENGCHAN
2"d place: 393 villages by Sengduangduan

3"d place: 393 villages by Phousavanh

4t place: 393 villages by Phapasit

5t place: 393 villages by Kaemery CHAO

6™ place:

Proximity Tools: Self-task Il

Hint: You can do this several ways; buffer tools and clip or select by location tool

Identify the villages within 10km distance to agromet stations

Answer: using buffer and clip tools

1. 10km buffer for Agromet Stations 2. Clip the village layer by 10km buffer

Savannakhet province, Laos map, 2019
Savannakhet province, Laos map, 2019
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Answer: using Select By Location tool
Hint: you have to do two types of operations

1. Identify the villages within 10km distance to agromet stations

Savannakhet province, Laos map, 2019

Overlay operations: Self-task |l

Hint: you have learnt all the tools to do this operation

Create a separate landuse layer within the distance of 10km from Agromet stations Type B and C. Then generate
area (sgkm) vs landuse type table and area percentage

Steps:
1. Select Agromet Stations Type Band C

2. Create a new layer of Agromet stations

Type Band C .
3. Create a 10km buffer for above layer
4. Clip landuse layer by 10km buffer
5. Calculate area
| Trpt bemg
6.

Use Summarize tool Togrosaes rpect

“55 Savannakhet province, Laos map, 2019
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Use of Intersect and Union tool
Understand the concept of these vector operations Intersect

1. Two layers use for demonstrate of these tool (Landuse and
Agromet stations)
2. Make a 5km and 10km multiple ring buffer for agromet
stations
3. Carefully check the attribute table of both layers before FEAIUKE
preforming analysis Union
Perform Intersect operation

Check and understand the generated attribute table

Perform Union operation

N o v s

Check and understand the generated attribute table

Use of Intersect and Union tool

Understand the concept of these vector operations

Union results Intersect results

51



Merge and Append tools

How to add newly established Agromet stations

How to add newly established Agro Meteorological Stations to

- . 5
the existing Agromet station dataset? X Coordinate

1. Right hand table shows the coordinates of new Agro 582722.43 1842666.56 10024
Meteoritical stations (coordinates in UTM 48N WGS84) 588543.56 1808271.36 10025
Make a new layer of newly established stations 649397.34 1850869.08 10026

3. Merge newly created stations with existing stations

4. Try append tool as well, as the second option

Home work
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l Home work - make a map similar to this

Savannakhet, Laos map, DMH
2019 MONRE

Participants Answers
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l Home work - Map prepared by Natnakhone

Project Site:

Savannakhet Province

446319 499765

1913611

1876173

1763857

553211 606657 660103

1 Legend

Province Boundary
PKHAMMOUAN =

o Villages

Rivers
Roads
Agro Met Stations

A Agro-met Station Type A
B Agro-met Station Type 8
®  Agro-met Station Type C
®  Agro-met Station Type D
Landuse Type
Agriculture Type A
Agriculture Type 8
Agriculture Type C
Agriculture Type O
Agriculture Type E
Agriculture Type F
B soeac Leaves
I e Green
I Forest Tyoe D
[ Forest Type €
Mixed Forest

Other Land

. e

Map Prepared by Natnakhone SAENGCHAN, DM e

446319 499765

Savannakhet, Laos map,

2019

553211 606657 660103

DMH
MONRE

l Home work - Map prepared by Phapasit

Legend
= Svannakr_village
Svannaket_road
—— Svannaket_rivers
Svannaket_landuse
[ <all other values>
Type_temp
Agriculture Type A
Agriculture Type B
Agriculture Type C
Agriculture Type D
Agriculture Type E
Agriculture Type F
Boread Leaves
I Ever Green
B Forest Type D
Mixed Forest
Il Other Land
Il Urban
Il Water
[ ] Svannaket_district
[ 1 GIS_phapasit_Shapefile
0510 20 30 40

Pl ™ ilometers

Savannakhet, Laos map,
2019

Map Savannaket Province

Mr Phapasit KHAMPHOUMY

DMH
MONRE
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l Home work — Map prepared by Phapasit

Savannakhet, Laos map,
2019

| wDVa e

Savannakhet, Laos map,
2019

Legend

DMH
MONRE

DMH
MONRE
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Savannakhet Map

Mayphou MAHACHALEUN

Savannakhet, Laos map,

Project Side:

Legend
* Agromet_stationt
® Station$ Events
® clip_viiages
— clip_rivers
—— clip_roads
landusesvk
[ <all other values>
Type_temp
[ Agricutture Type A
Agricuiture Type B
Agricuiture Type C
Agriculture Type D
[ Agricuiture Type E
Agricuiture Type F
Il Boread Le ves
Il Ever Green
Hll Forest Type D
[ Forest Type E
[1 Mixed Forest
e T [N Other Land
E Urban
R Water
[ savannakhet
DMH
MONRE

Savannaket Province

Agriculture_Station_SV
- O Vet
TYPE
*  AGOTe Suxor TypeA
Agome) Stror Type &
A AgD-mel Suroe Type C
¢ Agomes Suton Type D
—— Rwers_Savarmaer Cip
—— Ro3q_Saw
Landuse_ avannaket_Clip
D <20 oher Vet
Type_temp
Agramure Type A
Agragure Type &
B agamrenpec
5] agamreteo
Agramure Type €
d Agautire Type ©
- Boread Leaves
B e
Il oo
I [ rorearype=
Mxea Forest

PRBRONG -Mﬂ

o~

Prepared by Vongkham KEOOUDOM,DMH o

Savannakhet, Laos map,

[ svancame 0e

DMH
MONRE



Project Side: Savannaket Province

Agricuiture_Station_SV

Agro-me: Staton Type A
Agro-met Staton Type &

Agro-met Staton Type C

oo w3

Agro-met 51a80n Type O

Landuse_Savannaket_Clip
Type_temp
Agreugure Type A

Agneurure Type 8

PR agreunue mype

Agnaunure Type €
u AQreusture Type £
B coceooieaves
[
R s v

Forest Type £

o B ﬁ.ﬁ Vized Forest

[ LI
B o
e

Map Prepared by Chan amone Chanhajark.DMH [ savamateros

Savannakhet, Laos map,

2019

DMH
MONRE

Home wrok: teacher vs student

Teachers’'map

Project Site: Savannakhet Province

Mr. Natnakhone’s Map

Project Site: Savannakhet Province

Map Prepared by Kavinda Gunasekara, DMH

P.SARAVAN

Legend
5 Disrict Boundary
¥ [ Province Boundary
Vilages_Savannakhet

Rivers_Savannakhet

Roads_Savannakhet
Agro et Stations
Agro-met Station Type A
§ m Agomet Station Type 8
= e Agro-met Station Type C
©  Agro-met Station Type D
Landuse Type
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Vector & Raster Analysis
Part Il

Basic useful tools in vector & rater operations

(data use in this exercise is only for
demonstration purpose only)

Dr. Kavinda Gunasekara
Frank Yrle

Strengthening Agro-climatic Monitoring and Information Systems (SAMIS)
to improve adaptation to climate change and food security in Lao PDR

Learning topics

Overview o the exercise

W ® N o U B W N

Adding raster data: freely downloaded SRTM30 tiles
Explore raster data

How to make mosaic raster

How to clip raster data by a polygon

How to make Slope layer

How to make Aspect/hillshade layer

How to reclassify raster data

How to convert in between Raster and vector

Final vector overlay operation: finding best locations for

new Agro Meteorological stations
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How you can download free elevation data?

https://earthexpIorer.usgs.gov/\

1. Go to USGS EarthExplorer website

Laos map, 2019

How you can download free elevation data?
https://earthexplorer.usgs.gov/

/| 3.Goto “Search Criteria” and
draw your area

2. If you have an account please
login otherwise Register
yourself.

Savannakhet, Laos map, 2019
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How you can download free elevation data?
https://earthexplorer.usgs.gov/

— | 4. Go to “Data Sets”

_— | 5. Select SRTM =
SRTM 1 Arc-Second
Global

Savannakhet, Laos map, 2019

How you can download free elevation data?
https://earthexplorer.usgs.gov/

6. Go to “Results”

Savannakhet, Laos map, 2019

60



How you can download free elevation data?
https://earthexplorer.usgs.gov/

| - 6. Click download

7. Download: GeoTIFF

Downloaded SRTM 30m Elevation Data

Browse the downloaded using windows explorer
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How to open Raster data in ArcMap

Go to Add Data = browse your data folder

2. Click [Yes]

_— | 1. Select your data
and click [Add]

How to open Raster data in ArcMap

Elevation data

Savannakhet, Laos map, 2019
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Explore the added raster data
Use identity tool and try to change symbology

How to mosaic raster data

Making single raster for whole Savannakhet province

3. Input all other
rasters here

as [Target Raster]

/ 2. Assign one raster

1. Data
Management
Tool =» Raster =
Raster Dataset
=>» Mosaic

/ 3. Click [OK]
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Explore generated raster data

Check layer properties

Check cell size

Check
coordinate
system

Savannakhet, Laos map, 2019

How to reproject raster to a new coordinate system
WGS84 Lat Lon to UTM48N WGS84

/ N\

1. Data
Management Tool
=» Projections and
Transformations =
Project Raster

2. Input Raster

3. Output
Raster name

4. Output
Coordinate
System:
WGS_1984_UT
M_Zone_48N

5. Output Cell
Size: 30m

6. Click [OK]
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l Reprojected Elevation Raster

Savannakhet, Laos map, 2019

How to clip Raster data

Clip your elevation Raster to Savannakhet Province

/ 1. Data Management Tool =

Raster=» Raster Processing =» Clip

2. Input DEM

3. Savannakhet
province
boundary

4. Click this option

5. Output name:
DEM30m_SVK.tif

6. Click [OK]

65




Elevation data — Savannakhet province

Change the symbology to appropriate colors

How to create Slope

Slope layer of Savannakhet province

/ 1. Spatial Analyst
Tools =» Surface

=> Slope

Savannakhet, Laos map, 2019
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Slope Map — Savannakhet province

Slope classes in degrees

Savannakhet, Laos map, 2019

How to create Aspect

Aspect layer of Savannakhet province

/ 1. Spatial Analyst
Tools =» Surface
= Aspect




Aspect Map — Savannakhet province

See the Aspect classes

Savannakhet, Laos map, 2019

How to create Hillshade

Hillshade layer of Savannakhet province

/ 1. Spatial Analyst
Tools =» Surface
=> Hillshade
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How you can download free elevation data?

https://earthexplorer.usgs.gov/

Savannakhet, Laos map, 2019

How to re-class raster data

Necessary step if you want convert continuous raster data to vector

Try to reclassify your
elevation to
Min — 250m
250m —350m
350m — 450m
450m — 700m
More than 700m

_— | 1. Spatial Analyst Tools =
Reclass =» Reclassify
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How to re-class raster data

Raster reclassification steps

After adding data,

click [Classify]

How to re-class raster data

Raster reclassification steps

-

Assign your
elevation classes

Note down the old values

and new values
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How to re-class raster data

Display reclassified data

Savannakhet, Laos map, 2019

How to covert Raster to Vector data

Data convertion

Conversion Tools
=> From Raster =
Raster to Polygon




Elevation classes in vector format
Explore the attribute table

Savannakhet, Laos map, 2019

Overlay operations: Self-task V

Hint: you have learnt all the tools to do this operation

Can you find the area (in sqkm) of
. 0 — 20 degree slope
.  more than 20degree slope

lll. Optional: how many percentage of villages in 0-20
degree slope zone
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Overlay operations: Self-task V

Hint: you have learnt all the tools to do this operation

Find the best locations for a new Agro Meteorological Stations

Criteria:
1. 10km away from “primary” roads
2. 20km away from existing Agro Meterological Stations

3. Elevation more than 450m

Contact Us

kavinda@ait.ac.th
frankyrle@ait.ac.th

www.ait.ac.th
www.geoinfo.ait.ac.th (our center)
www.Facebook.com/gicait
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Coordinate Systems & Projections

A first look into the concepts that comprise
a Geographic Information System

Dr. Kavinda Gunasekara
Frank Yrle

Strengthening Agro-climatic Monitoring and Information Systems (SAMIS)
to improve adaptation to climate change and food security in Lao PDR

Overview
Coordinate Systems & Projections

1. Explore coordinate systems

2. Projecting Data in ArcGIS

3. Files without coordinate systems

4. Georeference a paper map
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Coordinate Systems
Coordinate Systems & Projections

GIS are different than other data systems because they contain spatial data

Coordinates

* Location
* Shape Two types of coordinate systems
* Extent

Geographic Coordinate Systems
Coordinate Systems & Projections

Merth Pele Ereenwich
o meridian

meridians

Curved surface

AN .
Geographic coordinates E ((Ef 5{ }3 Y £1 tg,;\ }-E\l\agﬁ
systems use a 3D spherical s 11 \L__j__}ji_?&‘qun‘tﬂr
surface to define locations R
on the Earth \

Sauth Pole——g¢
longitude

ESRI
Bolstad 2012
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What makes up a geographic coordinate system?
Ellipsoid

= : . A 1
| Ellipsoid 1= &R, b

Ellipsoid

* Originally measured with
astronomical observations

* Measured at continental level —
led to discrepancies in position

* More recently — GNSS and laser
observation

SEmi-minor axis

flattening
factor

What makes up a geographic coordinate system?
Poles & Equator

- Poles — defined by the axis of Greerwich
meridigns - merigian

revolution of the ellipsoid

* Equator —the circle mid-way 5 -
between two poles, at a right ////// / \ \ i
angle to the polar axis, and # Ef{ E;'I E 4 ’i}\ E;' %\
spanning the widest dimension of = ] Equatar
i N (>

the ellipsoid E\ \\1\ lll

l 475 parallels
R . .Sau'rh Pol Y
Coordinates can be defined .E "

longitude

Bolstad 2012
Fundamentals of GIS
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Geographic Coordinate Systems

Terms

Morth Pale Eree:nwi_.:h
meridians b B0 meridian

Latitude — varies from Nto S
Parallel = lines of constant latitude, / g
runs Eto W

Equator is 0° latitude

latitude
e
E tf“‘ﬁ:q
w 3
&
g

Longitude — varies from E to W \
Meridian = lines of constant longitude,
runs Nto S = porallels

South Pole———g0r

Meridians converge at the poles :
longitude

Prime Meridian is 0 ° longitude

Bolstad 2012
Fundamentals of GIS

An additional component of a coordinate system
Datum

Geographic coordinate system with ellipsoid, poles, and equator specify only the position
at the prime meridian

In order to know the other points on earth we must perform survey based on that

Datum is a reference surface
Datum is made up of: ellipsoid with a coordinate system & origin; set of points and lines
that have been surveyed

Governments typically have a surveying department to measure & maintain these points
The datum tells us the latitudes and longitudes of a set of points on an ellipsoid

Bolstad 2012
Fundamentals of GIS

77



Map Projections

Coordinate Systems & Projections

Map projections are necessary to transfer the
measurements made on an ellipsoid onto a flat map
Those measurements, or points, are projected from
the Earth surface onto a flat map

sUrTace

. ellipsaid

map

el'!ipsnid

L mﬂ[? 3
projechien i
"light” source

disfance Elt .-\-‘LFE
distance E & D_E

Bolstad 2012
Fundamentals of GIS

Projected Coordinate Systems
Shapes for projection

ESRI
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ESRI

ESRI

Projected Coordinate Systems
Shapes for projection

Projected Coordinate Systems
Shapes for projection
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Distortion in Maps W e ww ww

Coordinate Systems & Projectiol |
B

TN

W T RN W IWIT HE
L S0

O N ) IS O N
Distortion is inherent YRR R

in all maps for
distance, direction,

shape, & area

I -
. 4
RW W SW MWW W 1

Bolstad 2012
Fundamentals of GIS

Overview
Coordinate Systems & Projections

1. Explore coordinate systems

2. Projecting Data in ArcGIS

3. Files without coordinate systems

4. Georeference a paper map
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Start an ArcMap session
Blank map

Open ArcMap
At Table of Contents right-click Layers
Properties

Also notice the units

Adding Data & Coordinate Systems

Observe coordinate system

From ArcCatalog window add data:
Lao_bnd_admin0_ngd2018.shp
Right-click | Properties | Source tab

The data frame takes on the
coordinates of the first file added to it
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Adding Data & Coordinate Systems

Observe coordinate system

From ArcCatalog window add data:
Roads_utm.shp
Right-click | Properties | Source tab

These two layers have different
coordinate systems, but the data
can be visualized because ArcMap
is able to project on the fly

Projecting data

Observe coordinate system

Select the Search tool from the toolbar

Search for project

Click Project (Data Management) -
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Adding Data & Coordinate Systems

Observe coordinate system

At the Project tool
enter roads_utm.shp
for the input dataset

Specify a file name and
output folder

Finally select
geographic coordinate
system: WGS84

for the output
coordinate system

OK

Defining a projection
Observe coordinate system

From ArcCatalog window add data:
places_a.shp

You should see a warning message titled
Unknown Spatial Reference. This means the

places_a shapefile doesn’t have projection

information associated with it.

We can add a projection to a file that doesn’t
have one by using the Define Projection tool;
However, we should have some idea of what
the projection is beforehand
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Defining a projection
Observe coordinate system

Use the Search tool to find Define Projection

In this case it turns out that the projection is
WGS84, so select that at the Coordinate
System box

OK

Overview
Coordinate Systems & Projections

1. Explore coordinate systems

2. Projecting Data in ArcGIS

3. Files without coordinate systems

4. Georeference a paper map
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Paper Maps
How can we integrate
into a GIS?

Georeference

Performed on
scanned paper
maps to align
them with a
known coordinate

system Topographic Map of

Buriram Province, Thailand

Info needed to Georeference
Two Requirements

1. Metadata— l\ /I
Coordinate System,

Projection \\ //

2. Ground Control \
Points (GCP)
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Info needed to Perform Georeference
Two Requirements

1. Metadata -
Coordinate System,
Projection

2. Ground Control

Points (GCP) /

Coordinates for this GCP: /
X =285,000m E
Y=1,641,000m N

Applications of GIS

Many disciplines use GIS - B

1. Open the o |
ArcCatalog 3. At Item Desc.r|pt|on window
Window in select the Preview tab
ArcMap

—1

2. Find the file LuangPrabang_TopoMap_ 250000.jpg
Right Click and select Item Description...
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Applications of GIS

Many disciplines use GIS

g Some important info
present on paper map:
e Scale
* Year
* Creator
* Projection
e Spheroid
Activity:

Find each one on the map

Applications of GIS

Many disciplines use GIS

(Scroll down to
find Spatial
Reference Data)

5. Notice that the spatial reference is
unknown. We can find this

information printed on the map.

4. Open Properties for
LuangPrabang_TopoMap_250000.jpg
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Applications of GIS
Many disciplines use GIS

6. Click the Edit button

Applications of GIS
Many disciplines use GIS

8. Click Apply.
The coordinate system will be
updated with your selection

7. Search for UTM

- Navigate to Asia folder
- Find Indian 1954 UTM
Zone 48

9. Drag & drop
LuangPrabang_TopoMap_250000.jpg
from ArcCatalog window into the ArcMap
data view on the left.

Your Topo map will appear.
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Applications of GIS

Many disciplines use GIS

Add control \

Points

Select control points
to adapt a
coordinate system to
the scanned map

E Viewer
View raster layer to be referenced

_ View Link Table
10. Open the Georeferencing Toolbar Open the Link Table to edit and

Customize : Toolbars : Georeferencing examine the links

Applications of GIS

Many disciplines use GIS

12. Zoom to the top left corner

11. Click the Viewer button. of the map

The map will appear in the
viewer window.

89



Applications of GIS Upper Left
Many disciplines use GIS

14. A green cross will appear

where you clicked 2x
13. Press the

Add Control Points button. Use the
cursor to select the cross where the
arrow is pointing. Click 2x

Applications of GIS 15. Repeat for the other 3 corners of the image

Many disciplines use GIS
Lower Right

Upper Right

Lower Left B / -
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Applications of GIS
Many disciplines use GIS

16. There should now be
4 green crosses where
you 2x clicked the Ground
Control Points

Applications of GIS
Many disciplines use GIS

17. Click the
View Link Table button.

Enter the coordinates
from the map into X Map
& Y Map.

If you followed the same
order as the powerpoint, Link
1 = Upper Left

Link 2 = Lower Left

Link 3 = Upper Right

Link 4 = Lower Right
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Applications of GIS
Many disciplines use GIS

Press the
Full Extent button to if viewer
loses track of the map.

Link Location X Map Y Map
1 Upper Left 190000 2210000
_ 18.Enterthe 2 Lower Left | 190000 | 2110000
following coordinates:
3 Upper Right 340000 2210000
4 Lower Right 340000 2110000

Residuals
Many disciplines use GIS Residual is very high
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Rectify

Export your map

20. Select a location
and file name, then
click Save

19. Click Rectify to
begin export of the
georeferenced map

Results of georeferencing
Many disciplines use GIS

Before georeferencing

After georeferencing
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Activity

Georeferencing

Georeference the following image:

LuangPrabang_50000.jpg

Map Composition in ArcGIS

A first look into the concepts that comprise
- a Geographic Information System

Dr. Kavinda Gunasekara
Frank Yrle
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Topics covered in this section
Overview

Create new map

Exploring a map

Changing the symbol of features
Adding labels to a map

Laying out map

Saving map

N o v A~ W o

Exporting map

Opening ArcMap 10.6

New empty map

+Type Arcmap into the Windows search bar

+Select ArcMap 10.6

+Click Cancel
to open a
new, empty
map.
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Adding a layer to a map

Assessment of skills — Begin at conclusion of lesson

= Adding a layer to a map, click the Add Data button

= Select a layer’s name which you want to add to the map.

® Many layers could be selected as the same time
(hold SHIFT on key broad and click to select )
® Then click Add button

Removing a layer from a map
Table of Contents

=To remove a layer,
Right-click at the layer’s
name in the Tableof
Contents then select
Remove.

Laos map, 2019
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Review of map navigation tools
Located at toolbar

®To Zoom In click the button and Zoom Out click the L_'L

then drag a box around the portion to Zoom.

WK

®  For Fixed Zoom In click | ™ & | button and Fixed Zoom Out

click at

5 : button, the current display map will be zoomed.

= Click

&ﬂ] button to Pan the map.

=Click

button to do quickly zoom out to the map’s full extent.

Changing the symbol of features
Changing polygon features

= Right-click the layer’s name in the Table of Contents and click Properties

= Click the Symbology tab on the Properties dialog box, Click Features

x N
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Changing symbology

Properties menu

X

= Click the Symbol
button to change the
symbol.

» In the Symbol Selector dialog box, click a new symbol or
change specific properties of symbol. Then click OK.

Exercises to be completed on your own
Assessment of skills — Begin at conclusion of lesson

® At Layer Properties.
Click the Symbology tab,
then click Categories

= Click the Value Field, dropdown X
arrow and click the field that — —
contains the values we want to map.

= Click the Color Scheme dropdown
arrow and click a color scheme X

= Click Add All Values, Click Apply.
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Symbolizing Features

Unique Values

= Examine map colors
and Click OK button

Symbolizing Features
Sorting values

= To Sort unique value, in Layer o L
Properties, Click the Symbology tab.
® Click the Value column

® Click Reversed Sorting. Click OK

= To Order unique values, Click the Symbology tab.

= (Click the value you want to move up or down in the list.
= Use the up and down arrows to either promote or
demote the value in the list.

= Click OK.

Laos map, 2019
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Assigning new Label Heading
Accessed in Layer Properties Menu

= To give a new name for heading of a group value
Click the Symbology tab.

= Click at the heading in Label, and type a new heading.

= Then Click OK.

Changing the line features symbols
Assessment of skills — Begin at conclusion of lesson

= Right-click at the layer’s name of line layer in the table of contents, And click Properties.

® Click the Symbology tab on the Properties dialog box, Click Features

® Click the Symbol button to change the symbol.
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Draw a line layer showing unique values

Layer Properties Menu

= Right-click the line layer
and click Properties.
® Click the Symbology tab,
then click Categories

=Click the Value Field, select the field
that contains the values we want to map.

#Double-Click in each line feature value
to change the line style, size and color.

=Click OK.

e Smsor  Selectawy  [aplay

Laper Bropaton

Sow

Froalures

e callmgerion uming uripes voales of o el

[

Brtcdots  Fulde  Defribon Guery  Lobes Jorw L Relaien T HTUL Popun

b4

Changing point features symbols

Assessment of skills — Begin at conclusion of lesson

mRight-click at the layer’s name of point layer click Properties.

®Click the Symbology tab on the Properties dialog box, Click Features

®Click the Symbol button to change the symbol.
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Adding Labels to a map
At Table of Contents

Laos map, 2019

Exercises to be completed on your own
Assessment of skills — Begin at conclusion of lesson

" To change the label properties,
right-click at the layer’s name.
Select Properties, click Label tab.

"Then change the Method, Label
Field, Text Style, Text Symbol
and other properties. Click OK.
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5. Laying out a map

5.1 Using an Existing template
=Click View and click Layout View
X
X
s After entering Layout View X
the Layout toolbar will appear »Select Template catalog tab
and click a template style.
= Click Finish

=Click the Change Layout button to
change layout and select template

Making a map with a template
Adjust data frame

aClick the Select Elements button | k

Click the data frame to select it.

"The data frame is now outlined
with dashed line and has
selection handles at its corners
and edges. S —

2Click the resize cursor.
®Click the corner, drag it up and
to the left. "\

Laos map, 2019
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Making a map with a template
Adjust map elements

X
= Move other elements;
North Arrow, Legend frame,
Scale Bar and Title out of
the Data frame by clicking
and dragging each element.
X

Laos map, 2019

5.2 Creating your own map
No template used

= Click View > Layout View

Laos map, 2019
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Creating your own map
Insert a title

= Select the Insert menu, then select the Title
= Title appears on the page. Type in a logical title
such as “PROVINCIAL MAP OF LAO PDR”

= After the title is entered move your
cursor to the title and left click to select the
title then right click to bring up the
“Properties of the Title” window. Here you
can make other changes; for example
Change symbol is the button to use for
increasing the text size or changing fonts.

Creating your own map
Adding other map elements

= Select the Insert menu, then
select the North Arrow. Pick
one you like then select OK.

= The North arrow is put on
the page with a box around it.
Dragging it to where you want
it or resize it by dragging with
cornetr.

"Add a Scale bar, Legend, Text,
etc... as you did above.

Note: When adding the Legend accept default, select next and then finished.
Change the properties of the Legend matching with the layout later.
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Creating your own map
Adding other map elements

= Try laying out and styling
the map on your own.

Are there any areas you
would improve upon?

A closer look at the Layout toolbar

Assessment of skills — Begin at conclusion of lesson

= Zooming for layout map can be used zoom tools set
® This Zoom set use for Layout View, these will not
Change composition in Data View

Zoom Zoom Fixed
to 100%
In Pan Zoom Out
‘ w
Out Zoom Zoom In
Whole Page

Laos map, 2019

Toggle Change
Draft Mode || Layout
|
|
Focus || Data Driven
Zoom Data Pages
to Percent Frame Toolbar
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Saving a Map

Enter file name

= To keep the new map that you have created and also keep
the old template map, use Save As to save this map under a new name.

= Navigate to your directory and folder
= Type the map of map, Click Save.

Export map
Conversion to a common file format

Exporting map to another image format files to
present into another software; PowerPoint or add
your map into the report such as MS word.

®  Click File and select Export Map.
Navigate to your folder,

type new file’s name.

= Select format type of file such as:

.BMP, .JPG, .TIFF

= Options menu allows
modification of exported file
such as resolution and quality.
= Then click Save. X
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Table Management Using ArcGIS

A first look into the concepts that comprise
a Geographic Information System

|. Database File Handling

Overview

N o wu s

Start ArcGIS

Adding data

Field Data Management

a.
b.
c.

Sort data based on attributes
Obtaining statistics of attributes
Summarizing attributes based on a key attribute

Joining tabular data to spatial data and create new layer with tabular data

Relate tabular data to spatial data (understanding different between Join & Relate)

Table Management (select by attributes, graph, find & replace, etc.)

Adding and calculation in fields

a.

b.
C.
d

Adding new field/ Data types

Calculate geometry (area, length, perimeter, etc.)
Field calculator (assign new values, recode data)
Deleting fields
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Il. Selection
Overview

1. Identify features
a. ldentifying features by pointing to them
b. Change the filed on/off
c. Hyperlinks

2. Select features

a. Select by attributes
b. Select by locations using several layers

3. Select records

a. Interactively selecting records in a table
Selecting record in a table by attributes
Selecting all records

Clearing the selection

Switching the selection

0 oo o

Exercises to be completed on your own
Assessment of skills — Begin at conclusion of lesson

1. Calculate population density in Savannaket province

2. Recode the population density as Low, Medium,
High using your own class values

3. Symbolize using above three classes
4. Find and create a village layer - which are within a

distance of 800m to road layer
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Opening ArcMap 10.6

New empty map
+Type Arcmap into the Windows search bar

«+Click ArcMap 10.6

+Click Cancel
to open a
new, empty
map.

Set up at beginnning

Layer properties

Set Up Layer Properties

+ At Table of Contents: Right Click
“‘Layers” & select Properties

< Click “General Tab”

+ Type “Savannaket” in the name Text box
+ Set Map Unit “Meters”

+ Set Display Unit “Meters or Kilometers”
+ Click OK
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Adding Data from ArcCatalog

ArcCatalog window

<« Start ArcCatalog by clicking the
ArcCatalog button on the Standard toolbar

< Navigate to:
D:\ArcGIS_Training\GIS_Data\Laos
+ Hold down the Ctrl key to select several layers

» Population95_Village.shp

Adding Data from ArcCatalog

ArcCatalog window

« Drag & Drop the file
into ArcMap Data View

+ The selected layer is
added to the new data
frame
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Field Data Management
Interacting with Attribute Tables

a. Sort Data
+ Right click ‘Population95_Village’ layer

<+ Select >Open Attribute Table

Field Data Management
Adjusting field width

Columns are called fields in ArcMap

Widen fields by dragging the vertical line to the right of the field name
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Field Data Management
Rearranging field position field width

2x click a field name and drag
it to the position you like. This
is helpful for organizing data

Field Data Management
Interacting with Attribute Tables

a. Sort Data
« Right click ‘Population95_ Village’ layer
< Select >Open Attribute Table

+ Right click ‘DCODE’ field
< Select ‘Sort Ascending’ or

‘Sort Descending’
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b. Statistics

For a given field

+In ‘Population95 Village’ Attribute table,
right click ‘SUMOFTOTPE’ field

Select Statistics

0,
%

+ Table shows selected Field and statistics
> Count -- Total record
> Maximum
> Minimum
> Summary
> Mean

> Standard Deviation

l c. Summarize Data

Creates new table

< In ‘pop95 _vill" Attribute table,
right click ‘SUMOFTOTPE’ field

% Select Summarize

+ Select a field to Summarize: DCODE
< Choose one or more summary statistics
To be included in the output table:
> Click PCODE, check ‘Maximum’
> Click SUMOFTOTPE, check ‘Sum’
< Specify Output table, Click browse
D:\ArcGIS_Training\GIS_data\Laos\Sum_pop_disrict.dbf, click OK
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Creates new table

l ¢. Summarize Data

< Click Yes to add result in the map

+ Right Click “Sum_pop_disrict.dbf”

R/
*

*

Open

< Table show summarizing population in 1995 each district

Join Table to Feature
Bring attributes together

Establishes a one-to-one or many-to-one relationship

7’

Join the table containing the ‘Sum_pop district

tabular data to the ‘Savannaket _Province’ attribute
table, using “DCODE” as the common field.

<+ Add ‘Savannaket_Province’ from
ArcCatalog window

«Right click in the table of
contents and click Open Attribute
Table to see the existing attributes
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Join Table to Feature
Bring attributes together

Be able to join demography information via ‘DCODFE’

Table =P Attribute Table of Feature

Join Table to Feature
Bring attributes together

+ Right-click ‘Savannaket_Province’ (Destination Table) in the Table of Contents,
point to Joins and Relates, and click Join.

< Setting Field of
. . ‘Based on’ table,
— ‘Table to join’

and

‘Field in the Table’
to join on

+Click OK
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Join Table to Feature
Bring attributes together

Then open ‘Savannaket_Province’ Check the joined field

Join Table to Feature
Create new layer from joined data

< Create a new layer with joined tabular data
«+Right click on ‘Savannaket_Province’ > Data > Export data,
give the new layer name as ‘Savannaket_Province _pop’

<+ Add new ‘Savannaket_Province pop’ layer to ArcMap and see
the attributes.
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Relate
Relate data from two different layers

« Drag & Drop ‘Health_Facility’
from ArcCatalog window

Relate
Relate data from two different layers

% Click the third dropdown arrow and
click the field in the related table on
which to base the relate “DCODE".

+Type a name for the relate
“Population_District”.

< You'll use this name to access the
related data.
< Click OK

*,
0.0

Right-click the layer you
want to relate
“Savannaket_Province”,
point to Joins and Relates,
and click Relate.

Click the first dropdown
arrow and click the field in
the layer on which the relate
will be based “DCODE".

Click the second dropdown
arrow and click the table or
layer to relate to,
“Health_facility”, or load the
table from disk.
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Relate

Relate data from two different layers

Related information
appears when you
use the Identify Tool

Remove Relate
Return to previous condition before relate

R/
°

3

%

R/
°

R/
°

Click Identify Tool

Select Vilabouri district
Click the + symbol next
to Vilabouri to reveal the
related Health_facility
sub-menu

Opening the sub-menu reveals the names of
3 health facilities in Vilabouri district

Right-click  the layer
containing a relate you
want to remove and point
to Joins and Relates.

R/
°

Point to Remove Relate(s)
and click the relate you
want to remove.
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Find & Replace - Attribute Table ! '

Works like similar tools in MS Word or Excel

» Drag & drop Add Data ‘Laos.shp’
from ArcCatalog window

> Open Attribute Table In order to replace
text in a field you

» Go to Options, Right Click must enter editing
mode

> Select Find & Replace f

> Type ‘Bokeo’
» Click Find Next

Selecting by Attributes in Attribute Table

Completed within attribute table

| 1 » Open Attribute Table

» Go to Options, Select By Attributes,
select "PNAME" and click the = sign

»Click Get Unique Values to reveal a
list of province names

>Double-click Bokeo

» Click Apply

»Borkeo is now selected
on the map & in the
Attribute Table
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Examine other commands
Commands available for attribute table

Adding data & deleting attributes

Create and remove attribute table data

a. Adding fields to a table

R/
°

e
*
o

3

%

R/ R/
> ° °

*

*

4.3 Select All

4.4 Clear Selection

4.5 Switch Selection

4.6 Create Graph

4.7 Add Table to Layout

4.8 Reload Cache -- a temporary file,
or cache, help to display and navigate
data efficiently

4.9 Export

4.10 Appearance

Field
Record >

VL

Click Options in the table to which you want to add a field.
Click Add Field.

Type the name of the field.

Click the Type dropdown arrow and click the field type.
Set any other field properties as necessary.

Click OK.
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Data formats available

Attribute Table
Specific range Size
’ B H H

Name length, or format (Bytes) Applications

Short integer -32,768 to 32,767 2 numeric values without fractional
values within specific range; coded
Long integer -2,147,483,648 to 4 numeric values without fractional
2,147,483,647 values within specific range
Single precision floating approximately 4 numeric values with fractional values
point number (Float) -3.4E38to 1.2E38 within specific range
Double precision floating approximately 8 numeric values with fractional values
point number (Double) -2.2E308 to 1.8E308 within specific range
Text up to 64,000 varies names or other textual qualities
characters
Date mm/dd/yyyy 8 date and/or time
hh:mm:ss
A/PM
BLOB varies varies images or other multimedia
GUID 36 characters enclosed | 16 or 38 customized applications requiring
in curly brackets global identifiers

Examine other commands
Field Calculator

< Click Editor on the Editor toolbar and click Start Editing. You can make
calculations without being in an editing session; however, in that case, there

is no way to undo the results.
<  Right-click the layer or table you want to edit and click Open
Attribute Table
<  Select the records you want to update
<+ If you don't select any, the calculation will be applied to all records.
< Right-click the field heading for which you want
to make a calculation and click Field Calculator.
#  Use the Fields list and Functions to build
a calculation expression. You can also edit the
expression in the text area
<+ Optionally, you can type a value to set to the field.
+  Click OK.
<  Click Editor on the Editor toolbar and click Stop Editing
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d. Deleting fields from a table
Attribute Tables

< Right-click the field header in the
table window of the field you
want to delete.
» Click Delete Field.
« Click Yes to confirm the deletion.
« Deleting a field cannot be
undone. | |

Selection
View feature’s attribute data in Data View

The Identify tool allows you to see the attributes of your data.

a. Identifying features by pointing to them

Click the Identify tool on the Tools toolbar,
the Identify Results dialog box opens.

Click the mouse pointer
over the map feature you
want to identify, the
features in the topmost
layer under the pointer
will be identified.
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Hiding Fields

Alters visible attributes for identify tool

b. Format attribute data appearing in Identify dialog box

< Right-click the layer in the table
of contents and click Properties.

< Click the Fields tab.

# Click the Primary Display Field dropdown
arrow and click a field.

< Optionally, check the fields in the Name
column which are relevant to your map and
uncheck those that are not; or, click the
button in the Number Format column to
format your numbers.

< Click OK.

Another way to hide fields
Hide fields at attribute table

<+Another way to hide Fields — Use Attribute Table

% a. Right click field name and select Turn Field Off |

% To turn hidden fields back on: At attribute
table click Table Options
< Select Turn All Fields On
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Selection
Identify Features

c. Creating hyperlinks for the Identify Results dialog box

< Right-click on a feature's name
in the left pane of the Identify
Results dialog box, then click
Add Hyperlink.

% Click Link to a Document or Link to a URL,
% Click the Browse button to select a document or
type a URL, Then OK.

< To see the link, Right Click on Identify Results, Click
Hyperlinks.

Access Hyperlink

Identify Features

<+To see the link,

Right Click on

Identify Results, | |
Click Hyperlinks.

Another way to access the hyperlink:

+Click Hyperlink button

«Features with hyperlink will have blue outline
«Cursor will change to lightning bolt

«Click hyperlinked features to access website
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2. Select Features
Select by Attributes

< Click Selection on the Main menu and click Select By Attributes.

%  Click the Layer dropdown arrow and

click the layer containing the features you want to select.
< Click the Method dropdown arrow and click a selection method.
< Double-click a field to add the field name to the expression box.
< Click an operator to add it to the expression.
%+  Click Get Unique Values to see the values for the selected field.

< Double-click a value to add it to the expression.

Select by Attributes

Use attribute data to select features

« Click the Verify button to see if you are using proper syntax or if the criteria
you've entered will select any features .

< Click Apply.

< The status bar at the bottom of the ArcMap window tells

you how many features are selected.

< Use the Clear button to empty the expression box.

< Use the Save and Load buttons respectively

to save your current query as a file or load an existing one.

< The files used to save the queries have a .EXP extension but can be edited with
any text editor. Only the content of the expression box is saved in the file, not the
complete expression.

+ Click Close when you are finished selecting features.

126




O
e

R
<

°
”

The highlighted cyan features are selected because they intersect the red features

Select by Location
Use location to select features

Click Selection and click Select By Location.
Click the dropdown arrow and click a
selection method.

Check the layers whose features you would
like to select.

Click the dropdown arrow and click a
selection method.

Click the dropdown arrow and click the layer
you want to use to search for the features.
Check to use only the selected features.
Check Apply a buffer to the features in
<layer> and set the distance within which to

search for features.
Click Apply.

Select Features according to their location
Select by Location — Spatial Selection Method

Intersect -- This method is similar to the Are crossed by the outline of method but also selects any
features bordered by the reference features. For example, selecting wilderness areas intersected
by roads will select any wilderness area with a road running within its boundaries or alongside it.

When finding features that intersect with point features

When finding features that intersect with line features

When finding features that intersect with polygon features

Points Lines Polygons
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Are within a distance of
Select by Location — Spatial Selection Method

When finding features that are within a given distance

point features line features polygon features

The highlighted cyan features are selected because they intersect the red features

Are within a distance of -- This method selects features near or adjacent to features in the
same layer or in a different layer. For example, if you have a layer of clean and polluted wells,
you can find all the clean wells within 500 meters of the polluted ones. Or, you could find the
reservoirs and farms in other layers that are within this distance of the polluted wells. You can
also use this option to find features adjacent to other features. For example, you may have
already selected land parcels that your company might purchase, and now you want to get
information about adjacent parcels. In this case, you would select the parcels within zero
distance of the ones you've already selected.

Completely Contain
Select by Location — Spatial Selection Method

When finding point, line
and polygon features
completely contained by
polygon features

The highlighted cyan features are selected because they intersect the red features

Completely contain -- You can select polygons in one layer that completely contain
the features in another layer. For example, you can select forested areas that have
lakes completely within them. To select polygons that completely contain features a
certain distance within them, specify a buffer distance. For example, you can select

forested areas with lakes at least 500 meters within them by buffering the lakes.
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Are Completely Within

Select by Location

When finding features that
are completely within

polygon features

The highlighted cyan features are selected because they intersect the red features

Are completely within -- This method selects features in one layer that fall
completely inside the polygons of another. For example, you can select lakes
completely within a forested area. To select features that are a distance from the
edges of the polygon they fall inside, specify a buffer distance. For example, you

can select lakes that are at least 500 meters within a forested area.

i Have their center in -- This
Have Their Center In thod selects the feat .
Select by Location — Spatial Selection Method methoa selects € features In

one layer that have their center
in the features of another layer.

When finding features that have their
centers within a distance of point features

When finding features that have their
Points Lines Polygons centers within a distance of line features

When finding features that have their
centers within a distance of polygon features

The highlighted cyan features are selected because they intersect the red features
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Share a Line Segment With
Select by Location — Spatial Selection Method

Share a line segment with -- This method
selects features that share line segments,
vertices, or nodes with other features

You can't use this method to select point features

When finding features that share a
line segment with the line features

When finding features that share a line
segment with the polygon features

The highlighted cyan features are selected because they intersect the red features

Touch the Boundary of

Select by Location — Spatial Selection Method

Touch the boundary of -- If you are
selecting features using a layer
containing lines, this method selects
lines and polygons that share line
segments, vertices or endpoints (nodes)
with the lines in the layer. The lines and
polygons will not be selected if they
cross the lines in the layer.

If you are selecting features using a layer
containing polygons, this method selects
lines and polygons that share line
segments or vertices with the polygon
boundaries. The lines and polygons will
not be selected if they cross the polygon
boundaries.

When finding
features that touch
the boundary of ~
line features

When f|nd|ng
features that touch h C
the boundary of @

polygon features 3 A

You can't use this method to select point features.

The highlighted cyan features are selected
because they intersect the red features
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Are Identical to
Select by Location — Spatial Selection Method

When finding features that are identical to other features

The highlighted cyan features are selected because they intersect the red features

Are identical to -- This method selects any feature having the same geometry as a
feature of another layer. The feature types must be the same—for example, you use

polygons to select polygons, lines to select lines, and points to select points.

Are Crossed by the Outline of Are crossed by the outline of -- This method

Select by Location — Spatial Selection Method selects any feature having the same
geometry as a feature of another layer. The

feature types must be the same—for
example, you use polygons to select
polygons, lines to select lines, and points to
select points.

. When finding features that are crossed by the
outline of line features

When finding features that are crossed by the
outline of polygon features
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Contain
Select by Location — Spatial Selection Method

When finding
features that
contain point
features

When finding
features that
contain line
features

When finding
features that
contain polygon
features

Are Contained by

Contain -- This method
selects features in one layer
that contain the features of
another. This method differs
from the Completely Contain
method in that  the
boundaries of the features
can touch. For example, with
the Contain method, a forest
will contain a lake—and thus
be selected—even if the
border of the lake touches
the border of the forest. The
forest would not be selected
using Completely Contain
because the borders touch.

Are contained by
This method selects features in one layer that are
Select by Location — Spatial Selection Method contained by the features in another. For example, you
can select those cities that are contained by a county.
This method differs from the Are completely within

method in that the edges of the features can touch.

When finding features that contained by point features

When finding features that contained by line features

When finding features that contained

by polygon features

The highlighted cyan features are selected because they intersect the red features
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Select Records
Select records to select features

3.1 Interactively selecting records in a table

K3
<

K3
<

°
o

Open the attribute table for a layer on your map.

Click the leftmost column in the table adjacent to the record you want to select.

To select consecutive records, you can click and drag the mouse.

Press and hold the Ctrl key while clicking additional records.

Selecting Records in a table by attributes
Select by Attributes

3.2 Selecting records in a table by attributes

Click Options in the table you want to query and click
Select By Attributes.

Click the Method dropdown arrow and click the selection
procedure you want to use.

Double-click the field from which you want to select.

Click the logical operator you wish to use.

Click the Get Unique Values button, then scroll to and
double-click the value in the Unique Values list you wish to
select.

Optionally, you can type a value directly into the text box.
Click Verify to verify your selection.

Click Close.

Your selection is highlighted in the table.
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Selecting & Unselecting Records
Attribute table options menu

3.3 Selecting all records
% Click Options in the table and click Select All

3.4 Clearing the selected set
% Click Options in the table and click Clear Selection

3.5 Switching the selected set
« Click Options in the table and click Switch Selection

I11. Self Task

lll. Self Task

Assessment of skills

1. Calculate population density in Savannaket province

2. Recode the population density as Low, Medium,
High using your own class values

3. Symbolize using above three classes
4. Find and create a village layer - which are within a

distance of 800m to road layer
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Creating & Editing Data in ArcGIS

A first look into the concepts that comprise
a Geographic Information System

Overview
Topics covered during this lesson

Create a geodatabase
Create a feature class
Digitizing

Edit features

A S A

Skills Test
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Exercises to be completed on your own - Digitizing
Assessment of skills — Begin at conclusion of lesson

1. Access Subdivision Bookmark. Extend streets into

subdivision

2. Access Nam Ngum Reservoir. Add Nam Ngum Reservoir

to the Inland_Water feature class

3. Access the Airport Bookmark. Make a feature class
called Airport_Roadways; make a line feature class that
has separate domains for taxiway and runway; make a
feature class for apron

Opening ArcMap 10.6

New empty map

+Type Arcmap into the Windows search bar

«Click ArcMap 10.6

+Click Cancel

to open a
new, empty
map.
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Open the Arc Catalog Window
Getting started

O

Press the
ArcCatalog button
to open the
ArcCatalog window

Create a File Geodatabase
At Arc Catalog Window

Navigate to your preferred folder for this project
Right-click the folder and select New
We can see 2 types of geodatabases available:

File Geodatabase and Personal Geodatabase

Click File Geodatabase

This will create a file geodatabase in your
project folder
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Rename File Geodatabase

ArcCatalog Window Rename the geodatabase

Vientiane

The file geodatabase has 2x Click New File
been created and is visible =~ Geodatabase.gdb to
in your project folder rename it

Add data to the geodatabase

Feature Class (single)

Feature classes, tables, and raster data
can be added to a file geodatabase

There are options to add a single
feature class or multiple

Select Feature Class (single)
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Import feature class to file geodatabase

Single Feature class

Input Features:
Choose the Lesson 8
— Creating & Editing
Data folder

Select file:
Health_facility.shp

Output Feature Class:
Healthy fac

Click OK

Overview
Overview

The Health_facilities layer
is now in the Vientiane file
geodatabase. It also has
the name we assigned,
healthy_fac
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Renaming a feature class in a geodatabase
Overview

To rename: right-click a
feature class and select
Rename. Type new name
and click outside of text
box

Deleting a feature class from file geodatabase
Overview

To delete: right-click a
feature class and select
Delete. Type new name and
click outside of text box
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Add data to the geodatabase

Feature Class (multiple)

Multiple feature classes can be added
to a file geodatabase at once

Right-click Vientiane.gdb
Import | Feature Class (multiple)

Add data to the geodatabase

Feature Class (multiple)

Click the folder icon
for Input Features to
access the Lesson 8 —
Creating & Editing
Data folder

Shift-click Laos.shp &
roads_utm.shp, then
press Add

Click OK to add both
files to the file

geodatabase
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Add data to the geodatabase

Feature Class (multiple)

Drag & drop
roads_utm from the
Arc Catalog window
to the Data View

Change the

symbology to
Highway

Overview

Topics covered during this lesson

A R o

Create a geodatabase
Create a feature class
Digitizing

Edit features

Skills Test
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Creating a feature class in a file geodatabase
Overview

Right-click the file geodatabase ‘Vientiane.gdb’
New | Feature Class

Assign the name
Inland_Water

Creating a feature class in a file geodatabase
Selecting feature type

Here we define the type
of features that will be
in this new layer:

Point, line, polygon, etc.

Select polygon

Click Next to proceed

143



Creating a feature class in a file

geodatabase
verview

Assign a coordinate system
to the new feature class.

Use the same coordinate
system as the roads_utm
and Laos layers

We are able to easily
access that coordinate
system if the layer has
already been added to
map view by accessing the [
layers folder

Creating a feature class in a file geodatabase
XY Tolerance & Database Storage Configuration

Accept defaults
for XY Tolerance
& database
storage
configuration
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Creating a feature class in a file geodatabase
Adding a new field

Enter a new field name: Type
Data Type: Text

Limit the length to 15
characters for the Type field

Click Finish

Setting Domain Values
Helps prevent errors

Why set Domain values?

Prevents clerical errors when
entering attribute data

Misspelled attributes won’t
appear in a query; hinders
usefulness of attribute data
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Creating a Domain
Inland Water Bodies

Right-click the Vientiane.gdb
and select Properties

Enter the Domain tab

Domain Name: Type
Description: Type

Field Name: Text

Enter Code & Description values
Click OK

Assign Domain to ‘Type’ Field

Setting domain values

(

Open Properties for ‘Inland_Water
feature class

Click on Type at the Field Name box

At the Field Properties box (bottom
box) click the down arrow in the
cell to the right of Domain

Select Type

Click OK
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Overview
Topics covered during this lesson

Create a geodatabase
Create a feature class
Digitizing

Edit features

A S A

Skills Test

Overview
Topics covered during this lesson

3. Digitizing
a. Roads

b. Lake
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Adding a Basemap

Overview

Basemaps can assist with digitizing

Add Basemap — Imagery with labels

Bookmark
Factory Roads

Access the Factory location by
selecting Bookmarks | Factory Roads
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Activating Toolbars
Editor & Snapping Toolbars

The Editor toolbar
contains tools that
make it convenient for
creating and editing
features

Setting Domain Values
Overview

Turn on snapping at the
snapping toolbar by clicking
Snapping | Use Snapping

Don Chan riverside, Vientiane, Laos map, 2019
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Start an Edit Session

Overview

Initially the Editor Toolbar is initially grey because it is inactive.
It can be activated by selecting Editor | Start Editing

I

Inactive

Active

Create Features Window
Overview

The Create Features window
allows you to add features a
feature dataset

Click the Create Features
button on the Editor toolbar
to open it

Turn on the roads_utm layer
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Create Features Window
Overview

Click roads_utm in the Create
Features window to make the
Construction Tools window
appear. Select Line.

Setting Domain Values
Overview

Digitize a line from the
perpendicular road to the factory

At your last vertex right-click and —
select Finish Sketch

Repeat the process for the nearby
factory to the south. ) B -

Don Chan riverside, Vientiane, Laos map, 2019
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Setting Domain Values
Overview

The attribute table for roads_utm shows a field
called surface. There is a class called unpaved.
Next, add unpaved to the attributes for the

roads you just digitized.

Use the Edit Tool| * [to select the two lines you
just created. Then click the Attributes button

on the Edit toolbar. At the surface field enter o —
unpaved for both lines. s
Overview

Topics covered during this lesson

3. Digitizing

a. Roads -

b. Lake

Thatluang lake, Vientiane , Laos map, 2019

Use the Bookmark to go to Thatluang Lake
Drag & drop ‘Inland_Water’ from
ArcCatalog window to the Data View
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Creating a Digitizing Template for Inland_Water

Overview

Select the Organize Templates button
at the Create Feature window. This wil

| let

you create a template for Inland Watse

rto

digitize in that layer.

Click New Template
Select Inland_Water
Finish

Digitizing Template for Inland_Wa

Overview

ter

1

Thatluang lake, Vientiane , Laos map, 2019

A number of construction tools are available at the
Construction Tools window. Experiment with
different tools to understand how they work.

Circle
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Digitizing Tools at the Editor Menu
Polygon + Straight Segment & End Point Arc Segment

Selecting the ‘Inland_Water’ template at
the Create Features Menu, then selecting
an option from the Construction Tools
window makes more editing tools available

Straight Segment [ g End Point Arc Segment e
Digitize straight |« Create 2 vertices then move | =
segments cursor to form a curve

Digitizing Thatluang Lake

Create a polygon feature

Use Straight Segment & End Point
Arc Segment to digitize a polygon
representing Thatluang Lake

Hint: It is possible to switch Polygon

between tools while digitizing

The finished polygon should look
similar to the image on the right

Thatluang lake, Vientiane , Laos map, 2019
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Update Field Values for Inland_Water
Assign Type

Open the attribute Table for
Inland_Water

Click in the Type field
to select Lake

lll. Self Task

Assessment of skills - Digitizing

1. Add a Name field (text) to ‘Inland_Water’. Enter the name for
Thatluang Lake

2. Extend streets into subdivision
3. Add Nam Ngum Reservoir to the Inland_Water feature class

4. Make a feature class called Airport_Roadways; make a line
feature class that has separate domains for taxiway and

runway and digitize; make a feature class for apron and digitize
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Airport Terms

See image

Overview
Topics covered during this lesson

A I S A

Create a geodatabase
Create a feature class
Digitizing

Edit features

Skills Test
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Editing Features
Must be in Edit Mode

Delete features

Enable the Edit Tool

Click the segment that is to be deleted.
The segment will be highlighted blue.

Press the delete key on the keyboard.

Editing Features
Must be in Edit Mode

Move Vertices

Adjust vertices if it appears that
they are incorrectly placed.
Double-click the feature.
Vertices will appear

Drag & drop the vertices until
the feature achieves correct
position

Bookmark | Palace Entrance

Don Chan Palace, Laos map 2019

Bookmark | Crooked Road

Roads in Vientiane, Laos map, 2019
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Editing Features
Must be in Edit Mode

Cut Polygons Tool
Splits a polygon
feature into 2 features

Make sure snapping is on

Select Cut Polygons Tool
from Editor Toolbar I

Click two opposite ends
of polygon

Right-click and select
Finish Sketch

Editing Features
Must be in Edit Mode

Merge Tool
Combines two separate
features into one feature

Select the two features to

merge

Click Editor | Merge Result is single feature with
C—] combined geometry of the

Choose which feature to two features merged

merge into

OK
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Overview
Topics covered during this lesson

Create a geodatabase
Create a feature class
Digitizing

Edit features

LA A

Skills Test

Self Task

Assessment of skills - Editing

N

Create a Feature class called ‘Land_Plots’ in Vientiane geodatabase

. At Subdivision: Determine the size of one lot

Make one large polygon the size of 5 lots. Place onto the adjacent
undeveloped land and split into 5 lots.

Prepare enough house lots to populate the entire empty plot of
land

Extend roads from subdivision into the undeveloped land
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